
Kloks Contents

Introduction

Procedures
Solving the Puzzle
Using the Autosolver
Starting a New Puzzle
Presetting the Puzzle
Saving the Puzzle
Restoring an Old Puzzle
Exiting

Commands
Puzzle Menu
View Menu

Glossary
Defined Terms

Keyboard Topics
Puzzle Control Keys
Accelerator Keys
Numeric Keypad
Windows Keys

Disclaimer of Warranty



The Contents contains a list of all Help topics available. For information on how to use Help, 
press F1 or choose Using Help from the Help menu.



Disclaimer of Warranty

Users of Kloks must accept this disclaimer of warranty:

Kloks is supplied as is.    Homespun Software disclaims all warranties, expressed or implied, 
including, without limitation, the warranties of merchantability and of fitness for any 
purpose.    Homespun Software assumes no liability for damages, direct or consequential, 
which may result from the use of Kloks.



Introduction

Kloks was inspired by a similar puzzle designed by Erno Rubik.    The immediate goal is to get
all the kloks reading 12 o'clock.    This version adds a timer and a moves counter to add a 
little more challenge to those who discover the solution to the puzzle.    The goal then would 
be to minimize those two numbers.

Included is an Autosolver just to show that it can be solved as well as being fun to watch 
once or twice.    Register your copy and the Single Step mode will be provided (Big deal, I 
know, but I have to provide some incentive to register, right?  ).

A few hints are scattered throughout this Help facility, activated by clicking on this symbol

Contents 



Hint: Clicking on this symbol  will bring forth some small tidbit of information to assist you
in using this program.



Procedures

Solving the Puzzle

Using the Autosolver

Presetting the Puzzle

Starting a New Puzzle

Saving the Puzzle

Restoring an Old Puzzle

Exiting



Commands

Puzzle Menu
New
Autosolve...
Preset...
Save
Restore
Exit !

View Menu
Both Hands
Upper Hand
Lower Hand



Exiting

To exit the puzzle select Exit ! from the Puzzle Menu.



Presetting

To set all the hands to a particular state before trying to solve it, select Preset... from the 
Puzzle Menu.    This makes all the kloks accessible to the mouse; clicking on a klok will move 
the visible hand(s) to that position.    In the Both Hands view, both hands will move to the 
mouse position when clicked, in the Upper Hand view, just the upper hand will move, and 
likewise in the Lower Hand view; changing views can be accomplished by any of the usual 
means (menu, right-button popup menu, accelerator keys) as well as by clicking on one of 
the three little kloks in the dialog box. 

When all the hands have been preset, click on Ok in the dialog box to return to the normal 
mode.    Click on Abort to return the puzzle to its original state and return to the normal 
mode.    Click on Help to access this topic.



Saving

To save the current state of the puzzle select Save from the Puzzle Menu.



Restoring

To restore a previously saved puzzle select Restore from the Puzzle Menu.



Using the Autosolver 

To have the puzzle solve itself select Autosolve... from the Puzzle Menu.    A dialog box will 
appear to start, stop, step and cancel the solver.

Four buttons control the solver:

Go starts the solver
Stop stops the solver 
Cancel dismisses the dialog box.
Help calls this topic.



Select About... from the Help menu or read the Introduction for more information about 
this mode.



Starting a New Puzzle

To abandon the current puzzle and start a new one select New from the Puzzle Menu.



The puzzle is solved when all the hands are pointing to 12 o'clock. 



The 12 o'clock position is indicated by the larger hour marker at the top of each klok



Solving the Puzzle

The puzzle is solved when all the hands are pointing to 12 o'clock.

Only the hands of the four corner kloks can be manipulated directly.    The other hands are 
controlled depending upon the state of the four pushrods surrounding the center klok.

The pushrods link together one layer of hands  of the four kloks surrounding it.    The small 
jewel in the center of the pushrod will be the color of the hands that are currently linked 
together.    When the pushrod is out, the upper hands are linked, when the pushrod is in, the 
lower hands are linked.    When the corner klok is moved an amount all the hands linked to it 
will also move by that amount.

When the puzzle is solved a box will appear either congratulating you for solving it or stating
that the Autosolver was used to solve it; the latter will occur if the Autosolver's Go button is 
activated, even if it is stopped before the puzzle is solved.    Elapsed time since the last New 
command along with the number of moves used to solve the puzzle will be listed.

For more information, see also:

Manipulating the Kloks
Manipulating the Pushrods
Using the Autosolver



Moving the hands of a corner klok to a new position is counted as a single move, regardless 
of how many hands actually move and how far they move.    Changing the state of a pushrod
does not count as a move.



Hints

Click on a dot to reveal a hint:



Hint: It may be easier to work on just one set of hands at a time.    Make use of the View 
menu



Hint: The Autosolver does not solve the puzzle in the minimum number of moves.    You can 
do much better than it.



Hint: Using the SPACEBAR to increment the hands is very costly in terms of the moves 
count.



Hint: Save the current position before running the autosolver, then restore it and try to 
solve it in fewer moves.



The pushrods look like this  when pushed in.



The pushrods look like this  when pushed out.



View Menu

The View menu includes commands that enable you to choose which of the two layers of 
hands to hide or reveal.    This menu will also be called up by a click of the right mouse 
button on any of the kloks or pushrods.    Click the right mouse button on the "grooves" 
separating the kloks to pop up the Puzzle Menu.

For more information, select a View menu command name or icon.

Both Hands

Upper Hand

Lower Hand



Puzzle Menu

The Puzzle menu includes commands that enable you to start a new puzzle, start the 
autosolver, save the current state, restore a saved state and exit from the puzzle.    Clicking 
the right mouse button on or near the grooves between the kloks will pop up this menu 
without the Autosolve... command, but including the Help command.    Click the right 
mouse button on the kloks or pushrods to pop up the View Menu.

For more information, select a Puzzle menu command name:

New
Autosolve...
Preset...
Save
Restore
Exit !



View Both Hands Command

This command will display both the upper and lower hands of the kloks as in this icon.

See also:

View Menu
Upper Hand
Lower Hand



View Upper Hand Command

This command will cause the large dark blue lower hand to be hidden as it is here.    Using 
this command will emulate solving the physical puzzle where the hands are on opposite 
sides of the object.

See also:

View Menu
Both Hands
Lower Hand



View Lower Hand Command

This command will cause the thin light blue upper hand to be hidden, as it is here.    Using 
this command will emulate solving the physical puzzle where the hands are on opposite 
sides of the object.

See also:

View Menu
Both Hands
Upper Hand



Puzzle Exit ! Command

This command will immediately exit the puzzle.

See also:

Puzzle Menu



Puzzle New Command

This command will start a new puzzle by putting all the hands into a random state.    A dialog
box will appear asking you to confirm your decision if the puzzle is not in the solved state.

See also:

Puzzle Menu



Puzzle Save Command

This command will save the current state of the puzzle.    Only one puzzle can be saved at a 
time, saving overwrites any previously saved position.    If there is a previously saved puzzle, 
a dialog box will appear asking you to confirm this operation.

See also:

Puzzle Menu
Restore



Puzzle Restore Command

This command will restore a saved position to the screen.    A dialog box will appear asking 
you to confirm your decision to lose the current state of the puzzle.    This command is 
disabled until the puzzle has been saved.

See also:

Puzzle Menu
Save



Puzzle Autosolve Command

This command will activate the Autosolver control panel.

See also

Using the Autosolver



Puzzle Preset Command

This command will activate the Preset mode control panel.

See also

Presetting the Puzzle



Manipulating the Kloks

The Kloks can be manipulated with either the mouse or the keyboard. 

Mouse operation:

 Position the pointer over the face of a klok.    Single click will move the hands to the hour 
nearest the pointer.    Clicking on the marker of the desired hour is also allowed.    If the 
mouse button is held down, the face of the klok will appear to push in and the hour marker 
nearest the pointer will also appear to indent.    Move the pointer around within the face of 
the klok to select the desired hour.    Dragging the pointer off the klok face before releasing 
the mouse button will abort the move operation.

Keyboard operation:

 Focus the desired klok using the TAB or Shift-TAB key.    The DIRECTION keys will move the 
hour selection around the klok (indicated by the indented hour marker).    Hitting ENTER will 
move the hand to the selected hour.    Alternatively, SPACEBAR  will simply increment the 
hand to the next hour in a clockwise direction.    Holding the <Shift> key will cause the 
SPACEBAR to decrement the hand to the next hour in a counter-clockwise direction.    Using 
the SPACEBAR is most useful for getting a feel for how the pushrods connect the inner kloks 
together.

For more about using the keyboard, see also:

Puzzle Control Keys



The "face" of the klok is the area within the circle



The Klok is focused when the hour marks appear bumped out and colored the same as the 
upper hand.



Manipulating the Pushrods

 The Pushrods can be manipulated with either the mouse or the keyboard.

Mouse operation:

 Position the pointer over the face of a pushrod.    Single click will toggle the pushrod to its 
other position.    If the mouse button is held down, the pushrod will appear to toggle to its 
other state but does not actually change until the mouse button is released.    Dragging the 
pointer off the pushrod before releasing the mouse button will return it to its original state.

Keyboard operation:

 Focus the desired pushrod using the TAB or Shift-TAB key.    The state of the pushrod can 
then be toggled with the DIRECTION, ENTER or SPACEBAR keys.

For more about using the keyboard, see also:

Puzzle Control Keys



The face of the pushrods appear textured  

 when focused.



Manipulating the Pushrods

 The Pushrods can be manipulated with either the mouse or the keyboard. 

Mouse operation:

 Position the pointer over the face of a pushrod.    Single click will toggle the pushrod to its 
other position. If the mouse button is held down, the pushrod will appear to toggle to its 
other state but does not actually change until the mouse button is released.    Dragging the 
pointer off the pushrod before releasing the mouse button will return it to its original state.

Keyboard operation:

 Focus the desired pushrod using the TAB or Shift-TAB key.    The state of the pushrod can 
then be toggled with the DIRECTION, ENTER or SPACEBAR keys.

For more about using the keyboard, see also:

Puzzle Control Keys





Windows Keys

Choose from the following list to review the keys used in Windows:

Dialog Box Keys
Help Keys
Menu Keys
System Keys
Window Keys



Puzzle Control Keys

The following keys can be used whenever the main puzzle window is the current active 
window.

Key(s) Function

TAB Moves the focus from klok to klok then to pushrod to pushrod.
SHIFT+TAB Like TAB but in reverse order.
DIRECTION key Selects the destination for the focused klok's hands.

or
Toggles the focused pushrod.

ENTER Moves the focused klok's hands to the selected destination.
or
Toggles the focused pushrod.

SPACEBAR Increments the focused klok, moving the hands in a clockwise 
direction.
or
Toggles the focused pushrod.

SHIFT+SPACEBAR Decrements the focused klok, moving the hands in a 
counterclockwise direction.
or
Toggles the focused pushrod.



Accelerator Keys

The following keys provide quick access to the various menu commands and can be used 
whenever the main puzzle window is the current active window.

Key(s) Function

CNTRL+N Start a new puzzle.
CNTRL+A Activate the Autosolver dialog
CNTRL+P Preset the puzzle.
CNTRL+S Save the puzzle.
CNTRL+R Restore a saved puzzle.
CNTRL+X Immediately exit the puzzle.
F9 View both hands.
F10 View only the upper hands (hide the lower hands).
F11 View only the lower hands (hide the upper hands).



Numeric Keypad

The puzzle can also be completely controlled from the numeric keypad; the four corners of 
the keypad (1,3,7,9) control the respective corners of the puzzle.    Alone, they control the 
pushrods, with the CTRL key they increment the kloks, with the ALT key they decrement the 
kloks. The middle row (4,5,6) control the displaying of the hands.

Key(s) Function

KEYPAD5 View both hands.
KEYPAD4 View only the upper hands (hide the lower hands).
KEYPAD6 View only the lower hands (hide the upper hands).
KEYPAD1 Toggles the lower left pushrod.
KEYPAD3 Toggles the lower right pushrod.
KEYPAD7 Toggles the upper left pushrod.
KEYPAD9 Toggles the upper right pushrod.
CTRL+KP1 Increments the lower left klok clockwise.
CTRL+KP3 Increments the lower right klok clockwise.
CTRL+KP7 Increments the upper left klok clockwise.
CTRL+KP9 Increments the upper right klok clockwise.
ALT+KP1 Decrements the lower left klok counter-clockwise.
ALT+KP3 Decrements the lower right klok counter-clockwise.
ALT+KP7 Decrements the upper left klok counter-clockwise.
ALT+KP9 Decrements the upper right klok counter-clockwise.



Dialog Box Keys

The following keys can be used in the AUTOSOLVER dialog box.
Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.
SPACEBAR Selects or clears a check box.
ESC Closes a dialog box without completing the command. (Same as

Cancel)



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

SHIFT+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys
The following keys can be used in any window that has a menu bar.

Key(s) Function

ALT Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
ALT+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
ENTER Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

CTRL+ESC Switches to the Task List.
ALT+ESC Switches to the next application window or minimized icon, 

including full-screen programs.
ALT+TAB Switches to the next application window, restoring applications 

that are running as icons.
PRTSC Copies the entire screen to the Clipboard.
ALT+PRTSC Copies only the active window to the Clipboard.
CTRL+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Window Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
ALT+F4 Closes a window.
ALT+ESC Switches to the next application window or minimized icon, 

including full-screen programs.
ALT+TAB Switches to the next application window, restoring applications 

that are running as icons.
ALT+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.





Glossary

12 o'clock.
contents
face, klok
focus, klok
focus, pushrod
moves
pushrod is in
pushrod is out
single step
solved

Please send any suggestions for this topic to:

Homespun Software
162 Whitney St.
Northborough, MA. 01532






